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Forward 
 

Welcome to being a Coach for Northern Nevada High School Swimming and Diving. I am writing this 
handbook as a way to summarize, from a scorers perspective, all of the things that we will be expecting 
of you, all of the things that you should be expecting from me – as head scorer – and from your meet 
scorers each week. Additionally this document is intended to serve as a step-by-step guide to the most 
common functions you will be using Team Manager for.  

If you ever have further problems that I have not foreseen in this initial version of this document please 
let me know and I will help you and update this document as we problem solve together. 

Thank you all for giving back to the students and good luck this season, 

Chris Meyer 

Head Scorer 

Cmeyer.swimmeet@gmail.com 

  



NNHS Coaches Handbook  Version: 18-Feb-2025 
 

3 
 

What will you receive before the beginning of the season? 
Initial Roster 

Each year you will be needing to keep a comprehensive list of your swimmers (aka a roster) from 
which you will be making entries each week with. Rosters are kept via a Team Manager 
database. This roster will be built from a combination of three sources: Advancing athletes from 
the prior years roster, From a compiled roster provided by the head scorer, and from signups by 
new athletes, see below. Please note: Only ONE coach on each team should maintain a roster as 
each weeks entries shall be submitted as a singular file and not separated by gender or some 
other means.  

 From Previous Year: 
o You are able to use a previous years roster as the starting point for your current years’ 

roster. Make sure to make a duplicate roster (i.e. save as > new roster) so if you mess up 
the old roster is still intact. You will want to ‘age up’ your athletes so they show with the 
correct school year. Make all Senior athletes inactive, then make Juniors > Seniors, and 
so on through the academic years. 

o Basing your current roster on your old roster does have the benefit of keeping previous 
results as entry times without the difficulties of manually entering in all athletes’ best 
times or entry times. 

 From Head Scorer: 
o The head scorer will provide preliminary rosters based on last year’s results for all 

schools. These rosters may not have best times associated with the athletes so make 
sure to review your athletes entry times.  See section on importing rosters for further 
details on how this will be done.   

 From Signups: 
o Naturally there will be new athletes that will be added to your roster each year. These 

will mostly be freshman but may also consist of new swimmers. Among the roster-based 
information I highly suggest that you gather from those swimmers at the start of the 
year are listed below. All of these can and should be imported into your Team Manager 
roster. 

 Name 
 Gender 
 Academic Year  

 Important: these are listed as SR, JR, SO, and FR. Please refrain from 
using different formats. 

 USA Swimming ID 
 These are primarily ask for from Club Swimmers, and are completely at 

the option of the swimmer. Of note: these numbers have changed at 
some point over the last 5-ish years and the auto-generate functionality 
built into Team Manager no longer works. 

 Best Times 
 These can be collected and input into the TM software for your 

reference or as use for entry times. 
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 USA Swimming does offer a downloadable file of swimmers best times 
through the following link if you have their USA Swimming ID number. 

o https://data.usaswimming.org/datahub/usas/individualsearch 

Meet Schedule 
Each year there will be a schedule released with information on each meets Location, Date, Time, Meet 
Referee+Scorer, and Meet ID number. All of this information will be useful. 

This year I am testing out a new format for the Schedule. This way there is a concise way to show how 
many teams there will be at any given meet, and the team(s) that they will race against. The way to read 
this is to look in the “Team” column of a given meet for your team name, then you will look at the next 
column to see which team(s) yours will matchup with. The primary reason for this update was to make it 
easier for the scorers and refs to understand who all will be at a given meet and the matchups, and I do 
believe that this will be easier for you all as coaches to read as well. If anyone has any questions or 
suggestions about the schedule formatting please contact me to try to make the system work better for 
everyone. – Chris Meyer, Head Scorer 2/2025  

 

Meet Entry Files 
You will also receive a folder with every meet entry file for the upcoming regular season. This will come 
in a .zip file format. I suggest downloading the entire zip file to your computer, then decompressing it 
and copying out each meet that your team will participate in to the easiest location on your computer 
for you to access. See further for more information on how to import Meet Entry/Event files into Team 
Manager. 
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What is expected of Coaches before your First Meet of the season?  
Each team is expected to submit their rosters to the head scorer for administrative purposes. The head 
scorer needs a preliminary roster and a final roster by mid-season to make sure that all teams are 
maintaining a uniform format for their rosters. 

 The roster shall be transmitted to the head scorer in two file formats: 
o Team Manager file. See further instructions on how you will be able to export that file. 
o PDF Format. This shall be printed off from Team Manager and not from an alternate 

program 
 Rosters shall have the following for each swimmer: 

o Name 
o Academic Year (SR, JR, SO, or FR only) 
o Gender 
o Club Swimmers should have their USA swimming ID in the roster. 

What is expected before all in-season meets (Dual Meets + Aqua 5’s) 
Each week coaches will need to send their in their entries according to the information listed below. 
Please note: all entries are due a Minimum of 48 Hours prior to the listed starting time unless requested 
to be earlier by your meet scorer. Any timeline set forth by your meet scorer supersedes this minimum 
timeline. 

 Entries shall be in the form of the following: 
o Team Manager Entry File.  
o PDF Copy (this is optional but it makes changes easier prior to the meet) 

 Entries shall be sent to the following people: 
o Meet Referee 
o Meet and Head Scorers 

Once all teams’ entries have been received and reviewed by the meet scorer, they will confirm your 
entries by sending the coaches a pdf printout of what they received. Please make sure to review that file 
and correct any errors. The earlier errors are recognized and brought to the attention of the scorers the 
easier it is to get them corrected. 

If changes are necessary to the entry file please keep changes limited to the following conditions to 
maintain competitive fairness. Changes are not meant to be complete overhauls of your entries but are 
intended to help minimize changes on deck the day of the meet. 

 Errors found crosschecking the returned entry report from the scorer 
 Changes due to a planned student absence (sickness, family trip, etc.). 

If changes to your entries are submitted between prior to 24 hours before the listed start time for the 
meet, the changes shall be sent to the scorer in the same manner as the initial entries, except please 
keep written backup of those changes in case they are missed. 

If changes to your entries are submitted less than 24 hours before the listed start time for the meet, 
those changes will have to take place on deck the day of the meet. 
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What is expected when you arrive to an in-season meet 
When you and the scorer arrive to the pool, please check in with the scorer as soon as they have their 
equipment set up. This is the time when you should communicate any changes you have to your entries. 
The deadline for these changes is 30 minutes MAX prior to the start of the meet.  

What happens after each in-season meet 
By the end of the weekend each week the head scorer will send out the week’s results via email. This 
will happen approximately by the end of Sunday night. The results may be sent out prior but that is only 
if there is enough time on the head scorers schedule for processing the results. 

When the head scorer sends out the weeks results that will include both a result file for Team manager 
as well as a PDF copy of each meet. Please make sure to review the PDF results for errors prior to 
importing results.  

Results will be available on the website sometime Monday. See Link below. 

https://www.gomotionapp.com/team/recnvsnhssd/page/north-results/2025 

Meet Entry Rules 
Dual Meets 

 5 entries per team for all individual events except 50 Free and 100 Free. 50/100 have no limit. 
o 3 Relay Teams for 200 Medley and 200 Free Relays 
o 2 Relay Teams for 400 Free Relay  
o Swimmers are limited to 2 individual and 2 relays or 1 individual and 3 relays. 

Aqua 5 
 Each swimmer may enter all 5 events. For the high point awards the swimmer must successfully 

swim all 5 events. There are no relays 

Regionals Championships 
 Limited to 4 per team for all individual events (swimmers need to meet or exceed the regions 

qualifying times in a high school meet that year  
o Swimmers cannot use times from USA swimming or from a previous high school season 

to qualify for regionals. 
2. Limited to 1 relay team in each relay. 
3. Swimmers are limited to 2 individual and 2 relays or 1 individual and 3 relays. 

o These options are decided at the time of entry, not when final scratches are due. 

Nevada State Championships 
o Top Finishers from the Regionals Championships qualify for the State Meet. 
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How to Use Team Manager 
Team Manager is a software provided by Hy-Tek. Hy-Tek is the preeminent software provider for 
running swim meets and for teams managing swim rosters. There are tons of additional resources 
provided by Hy-Tek on how to use Team Manager through their built in help function and on their 
website. If there is a question I have on using their softwares I often have good luck googling the 
problem I am having while listing “Hy-Tek Team Manager”. This “How To” handbook is intended to be a 
more concise help function built for how we use Team Manager and is not intended to be a complete 
documentation of everything that Team Manager can do. 

Create/Duplicate Roster Database 
1. File > Open/New 

 

2. Save in the location of your choosing. If you are starting from scratch (top bar reads “No 
Database Open”) you will be creating a new database. If you have a different database open (i.e. 
last years database) The new database will keep the last database’s information. 
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3. Set up System Preferences. See selections below 
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Import Roster 
1. Download Roster Database .zip file (provided by the head scorer at the beginning of the year) 

and navigate to that download location 

 

2. Click “Extract All” in the Compressed Folder Tools > Click “Extract”. 

 

3. Take Note of where this file is saved. 
4. In Team Manager go to File > Import > Athlete Rosters 
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5. Navigate to where the Extracted Folder is and select your team to import and Click Open 

 

6. Click “OK” Through this page. Make sure “Update/Add Athlete TM Group/Subgroups/School 
Year” is selected. This keeps the standard format for school years that we prefer. 

 

7. Click “OK”, then “Close” and you have that team imported. 
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Create/Edit Team 
1. Open the “Teams” Tab  

 

2. If you are wanting to add a team you are able to under “add”. The best way to do this in a blank 
database is to import a roster as provided. This way the naming convention and other 
information matches previous versions. 

3. To edit the information on an existing team by selecting the team, then “edit” 

 

4. If you are wanting to add additional information that is your choice, but the above selections are 
all that are necessary. If you don’t know the information that is needed in that screen please 
contact the head scorer. 

Create/Edit Athletes 
1. To Add or Edit Athletes from the home screen click “Athletes” 
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2. If you are intending to Add an Athlete click “Add”. If you are intending to edit an existing athlete 
select the athlete you wish to adjust and click “edit”. These options bring you to a similar page, 
but if you are adding athletes every time you hit “OK” it will open a new blank athlete for you to 
keep adding.  

 

3. Below are a list of items you need to ensure are filled in 
a. Last Name 
b. First Name 
c. Gender (M/F) 
d. Team 1 
e. School Yr 

4. Click OK to Save changes or to add athlete. 
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Age-Up Athlete School Year 
1. In Team Tab go to Maintenance > School Yr Update 

 

2. Start by Upgrading Seniors to InActive with settings below. And Click “OK”. 

 

3. Next Make Juniors > Seniors 

 

4. Make Sophomores > Juniors 
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5. Make Freshman > Sophomores 

 

Export Roster 
You will need to export these two file formats for the Head Scorer at the beginning and at the end of 
each year. 

Team Manager File 
1. File > Export > Athletes/Teams 

 

2. Select team and navigate to where you would like to save the file in the directory to the left. 
Click “OK”. 
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PDF File 
1. Navigate to Reports > Administrative Reports > Athletes 

 

2. Select options from below to make sure from list below and then click “Create Report” 
a. Only Registration ID is selected from the checkbox 
b. Your team is selected 
c. Sort by Name 
d. Both Genders 
e. Neither option is selected from Athlete Status 

 

3. Click the “Print” icon which is the Second icon on the top left. 
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4. Select your favorite option to print to PDF and hit “Print” 

 

5. Navigate to where you would like to save the file and Click “Save”. 

Import Meets 
1. Download Roster Database .zip file (provided by the head scorer at the beginning of the year) 

and navigate to that download location 

 

2. Click “Extract All” in the Compressed Folder Tools > Click “Extract”. 
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3. Take Note of where this file is saved. 
4. See Schedule provided by Head Scorer and take note of all Meet Numbers that you will compete 

in (i.e. 2501) 
5. In Team Manager go to File > Import > Athlete Rosters 
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6. Navigate to where the Extracted Folder is and select your meet to import and Click Open. You 
will only be able to import one meet at a time. It will direct you to unzip each file then open the 
.EV3 File that it provides and hit “OK”. 

 

7. Select Save on the Meet Setup dialog box that opens until it takes you to the Meet Browser. 
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8. For Regionals Only: You will need to select the “Use Times Since” box as entry times for 
Regionals are required to be earned in the given year during high school meets. This is found on 
the Meet Setup dialog > Eligibility Rules Tab. Use an entry date of 2/1 of the given year. If you 
have already saved the meet you can double click on the meet to find this dialog box. 
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Enter Meet 
To navigate to the meet browser click “Meets” in at top of the home screen. 

 

Meets are organized by default as Start Date with the latest date meet at top. Make sure you have the 
meet you are intending to enter highlighted. 

There are two primary ways to organize your entries: By Event Number or By Athlete. Of note: you can 
only enter relays by event number, which makes it easier to do all you entries in; but if you prefer seeing 
you entries by athlete there is that option. 

Entry by Event Number 
1. In Meet tab > Entries > Entries by Event. 

 

2. Make sure you select in two locations which team you are making entries for. 

 

3. To enter Relays first add the number of relays you are intending to enter for the meet. You can 
Adjust an entry time by clicking under the “Custom” column then typing in an entry time. 
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4. To enter Athletes you can select the relay you want an athlete in, then double click your athletes 
in the order they will swim. You can also adjust order of swim after they are entered by dragging 
and dropping them into the desired order. 

 

5. To enter athletes into an individual event you need to select on the event, then click the “Entrd” 
box for any athlete that you want entered. The number of entries that athlete is entered in will 
update in the IE, RE, and CE columns and it will give you an error message if an athlete is 
entered in too many events. You can enter in a custom entry time in the “Custom” column here. 
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Entry by Athlete 
1. In Meet tab > Entries > Entries by Name. 

 

2. Make sure you select in two locations which team you are making entries for. 

 

3. To enter athletes into an individual event you need to select on the athlete, then click the 
“Entrd” box for any event that you want that swimmer to be entered in. You can enter in a 
custom entry time in the “Custom” column here. If you Select the box for “Show Relay Entries” 
you can see if an athlete is entered in a relay, but you wont be able to enter athletes in relays 
from this page. 
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Export Meet Entries 
1. To export your meet entries go to File > Export > Meet Entries 

 

2. In the dialog box that opens you can select which meet you are exporting entries to and where 
you would like to export them to in the directory. Make sure the “Export Relays” box is selected. 

 

PDF Version of Meet Entries 
1. In the Meets tab go to Reports > Entry Report 
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2. In this dialog box you can select which meet you want the report for. Sort by Name. Filter by 
“individual and Relays”. 

 

3. Print this report to PDF and save where you would like.  
4. Send this report in with your entries to your meet scorer each week. 

Import Meet Results 
1. You will need to import results of your meet each week to make sure entries are available for 

Regionals. To import results go to File > Import > Meet Results. 

 

2. Follow the directions on the dialog boxes and Click “OK” 


